
Getting the most of MMF for Power 
Users! 

   
by Andy H 

   The first Multimedia Fusion Getting the most of described how to configure the working 
environment for an 800 by 600 display. This article targets the power users who want to 
get more out of MMF at a higher resolution, typically 1280x1024 or bigger. However 
many topics covered here are applicable to other configurations.  

 Quick links 
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 Screen Orientation  

  

 
click this image to see it full size (1280 x 1024) 

 The first thing you may notice is every window is maximised or docked. 
This helps keep the environment less cluttered. A dozen windows can quickly 
fill the MMF workspace. 



 The toolbars are completely rearranged, some buttons are gone, some 
new buttons have been added. The shape of a 1280x1024 screen provides 
over 200 pixels extra in width than height, so to take advantage of this, most 
of the toolbars are down either side of the screen. 

 The application properties and library windows are always docked at the 
top of the screen. I rarely use the Library window, so this could be removed 
completely. When I'm working on more that one application, I will place the 
application windows side by side along the top, which helps conserve space. 

 In the above screen, you can see the Frame window is open. Here is 
where more horizontal space is a benefit. The objects pane of the frame 
window has a default width of 1 object, but for improved productivity, resize 
this to show 2 or 3 columns of objects. Right click anywhere in this area and 
you can choose how to arrange the icons...a very useful undocumented 
feature! 

 The Colour Palette window normally appears along the bottom of the 
screen when you open a picture editor. Due to the Corel styling you'll only see 
one line of colours. To reach more, you can click the left and right buttons or 
the pop-up button for a temporary full view of the palette. For faster access to 
the colours you need, undock the window by dragging it off the bottom, and 
rest it carefully in a spare space over the Library window. Be careful not to 
dock it at the top while you do this! At present MMF will not remember its 
position, so next time you start MMF you will need to reposition it. 

 Customising the Toolbars 

Toolbars can be customised in a number of ways. You can ALT+drag a 
toolbar button to move it somewhere else or remove it. You can also 
CTRL+drag to duplicate the toolbar button. This is extremely useful for 
buttons and controls that do not exist in the Toolbar - Customize windows. 

To open the Toolbar - Customize window, select Edit - Toolbars... and click 
the Customize button or right click on any toolbar. 

 

The layout of the toolbars are really a personal preference, however here 
is one productive layout with the toolbars down the side of the screen: 

 Main Toolbar - This normally contains several file and edit 
commands such as load, save and undo. I only need New, Open, Save 
and Create Application on this toolbar. I always access Undo with 
CTRL+Z on the keyboard and Redo with CTRL+Y. I can access other 
less used commands from the menu's. 

 Tip: To insert dividing lines between toolbar buttons, while the 
Customize window is displayed, drag the button a couple of pixels away 
from its neighbour. To remove a dividing line, drag it back towards its 
neighbouring button. 



 

 Custom Toolbar - For editing graphics in the Picture Editor I need quick 
access to my favourite functions. I have created a new toolbar (use View-
Toolbars...) to house these functions. 

 Crop - The first button I've added is Crop, which is normally located 
under the Object menu. This button allows you to reduce the canvas 
size by cutting off the empty space around a graphic. 

 Enlarge Canvas - to enlarge or reduce the drawing area, referred to 
as the canvas. 

 Erase - to clear the image (fills with transparent ink). 

 Three Colour Inks - You will normally find these on the Status Bar, 
across the bottom of the screen. However, the order that they appear 
is back to front for right handed mouse users so I have copied them 
onto this toolbar. To copy these, CTRL+drag each colour box onto 
your new toolbar. Remove the dividing lines by dragging them closer 
to each other. You can also resize them if you wish by dragging their 
right edge inwards. 

 Flip and Rotate - The next four buttons will flip and rotate the 

 Navigation Toolbar - Next down is the Navigation toolbar. Normally 
containing the next, previous frame and editor buttons. I have only kept 
hold of the Previous and Next Frame buttons. The Frame Editor and 
Event Editor are the most common editors I use, but I have opted to 
remove these too as the shortcut keys are much quicker. Use CTRL+M 
for the Frame Editor and CTRL+E for the Event Editor. 

 I have also added Zoom buttons. These are probably one 
of the most useful Frame Editor functions that have been 
added to MMF. They allow you to zoom out to get a bigger 
picture of what you are editing and zoom in up close when 
you need to position an object accurately. 

 Vertical Settings Toolbar - It's best not to mess with this toolbar as it 
changes for each window you have focus on. It also has all the 
commands you need. 

 I have opted for this toolbar to be positioned at the bottom. 
This is because most of the picture editing commands are 
located at the bottom of the screen, a trend you'll notice in the 
next set of toolbars. For example, the frame controls for the 
Frame Editor and Picture Editors are always located in the 
bottom left of their respective windows. 



current image. 

 Import - The last two buttons allow me to import a bitmap and 
animation. These are normally found under the File menu, but are 
easier to access here. 

 

 Horizontal Settings Toolbar - As with the Vertical Settings toolbar, leave this 
one alone. It is normally found near the top of the screen, here I have positioned it 
at the bottom close to the other picture editing functions. 

 

 Text Toolbar - This is another custom toolbar. Very useful for formatting text 
objects, it has the most commonly used text formatting functions. To use space 
more efficiently, this toolbar is positioned over the top of the title bar. Care must 

 Run Toolbar - Over the other side of the screen, I have docked the 
Run toolbar at the top right. I like to keep the Play button on here 
because sometimes I'll need to see what is going on in the grey holding 
area outside of the frame. 

 Positioning the Run functions here makes them easy to 
get to. I more commonly use the shortcut keys F7, F8 and 
F9 to run Frames, Applications and Projects respectively, but 
its useful to have the icons here as well. 

 Objects Toolbar - This toolbar will also be found at the top of the 
screen by default. Again, I opt to position it down the right edge of the 
screen to give me quick access to them. 

 There is already a good selection of objects on this 
toolbar. 

 I use dividing lines to group together related objects, such 
as graphics, text & strings, controls, data storage and so on. 

 I have also added an Insert Object toolbar button at the 
top. With this I can choose what object to add if it is not on 
the toolbar. 



be taken not to dock the toolbar while positioning it here. 

 Preferences 

Much of what is discussed here has been covered in Getting the most of 
MMF on a 800x600 display, so this section will be brief. 

 

 The main point to keep in mind about the preferences is to ensure that the 
settings work best for MMF with maximised windows. As shown above, make 
sure all windows are docked when they are opened. 

 MMF seems to work better with less undo levels. I happily use 4 levels of 
undo. 

 It is important to make sure Autosave is off and Autobackup is on. I like 
MMF to keep 10 backups of my current file, just incase anything goes wrong! 
However, don't take this feature as your only protection. I will change the 
name of my working file (using Save As from the File menu) when ever I 
make a major change by adding a number to the filename. Think of this as 
the build number. 



 

 Likewise, the picture editor and animation editor will be opened full screen. 
Turn on the options to Exit on Escape and Auto-save at close. When you 
have finished working in these editors, just hit the Escape key. If you don't 
want to keep any changes you made, press CTRL+Z to undo the operation. 

 There are a number of other tweaks that you may want to make in the 
preferences. For example, I reduce the default zoom scale for the event editor 
to show more events and action columns. I also turn on the options to show 
object names in the event editors. This is a purely personal preference and 
you will undoubtedly have your own preferred settings. 

 Working with windows maximised 

The original Click and Create had very few windows and they were usually 
maximised. The main windows were Storyboard, Frame Editor and Event 
Editor. The Picture and Animation editors were modal dialog boxes which the 
user had to close when they had finished working in them. This way of 
working was adopted and loved by the majority of users. 

Multimedia Fusion changed all this in the most chaotic way a CnC'er could 
image! Instead of three main windows and a few dialogs, everything was in a 
window. Experienced CnC users suddenly had to learn a new way of working. 
Upon closer inspection however, things do make sense! The trick is learning 
to work with MMF instead of against it. This section is probably the most 
valuable part of the article. 

 Starting a new application  

When you create a new application, or load in an existing one, open one 
Frame Editor window and maximise it. This is how we will work from this point 
on. 

 Moving between Frame Editors and Event Editors 

To open the Frame Editor, always press CTRL+M. Train yourself to get into 
the habit of using the short cut keys where they are available. In the long term 
this will save you time. 



To open the Event Editor, always press CTRL+E. Never open a Frame or Event 
Editor while you are editing in any other type of window, such as the 
Picture/Animation Editors, Behaviour windows and Edit the Actions windows 
(see below). Doing so will leave these windows open! 

 Changing the frame you are editing 

You will notice that there are navigation controls at the bottom of the Frame and 
Event Editors. Use these to go to the next and previous frames in your 
application. If you open one of these editors from the Application window, you 
will begin to have duplicate editor windows left open in the background. 

 Closing the Picture and Animation Editor windows 

Remember we set the Picture / Animation preferences to save and close when 
the Escape key is pressed? Do this to close the window when you have finished 
editing in them. Never leave these open if you need to move elsewhere! 

 Closing Behaviour, Edit the Actions and other windows 

When you open a Behaviour window, you'll see a conventional event editor. If 
you leave behaviour windows open, they will accumulate in the background. 
Likewise, when you choose the Edit the Actions command in the event editor, it 
will remain open until you close it which can cause problems later on. 

To close these windows, simply press CTRL+F4. Do not confuse this with 
ALT+F4 as this will close Multimedia Fusion! Always close these windows when 
you have finished using them. 

 Essential Short-cut keys 

There are a lot of buttons, menus and options in Multimedia Fusion. Like most 
software, MMF has accelerators, or short-cut keys for some of the most popular 
commands. Short-cuts can also be defined for the majority of menu options and 
buttons, so MMF can be tailored to your needs. 

To work faster in MMF, train yourself to use these short-cut keys where ever 
possible. Keys marked with an * are custom key commands I have added to the 
cncdef.acl file. Copy it to your MMFusion\Programs folder if you want to use 
them, but back up the original file first if you wish to return to your configuration. 

 Program Editor Keys 

 CTRL + M 

 CTRL + E 

 CTRL + T 

 CTRL + L 

 CTRL + B 

Open Frame editor window 
Open Event editor window 
Open Time Line editor window 
Open Event List window 
Open Storyboard window



 Program Execution Keys 

 Editing Keys 

 File Operation Keys 

 Windows Keys 

 Frame Editor Keys 

 Picture Editor Keys 

 F9 

 F8 

 F7 

 F5 

Run Project 
Run Application 
Run Frame 
Play the Frame

 CTRL + Z 

 CTRL + Y 

 CTRL + X 

 CTRL + C 

 CTRL + V 

 CTRL + A 

Undo last operation 
Redo last Undo operation 
Cut the selected object into the paste buffer 
Copy the selected object 
Paste contents of paste buffer 
Select All

 CTRL + N 

 CTRL + O 

 CTRL + S 

New application, project, library or image 
Open file 
Save file

 CTRL + F4 

 Esc 

 CTRL + F6 

Close open window 
Close Picture/Animation editors 
Next Window

 F4 

 F2 

 F3 

 F6*  

 CTRL + Shift + PgUp* 

 CTRL + Shift + PgDn* 

 CTRL + Shift + Up* 

 CTRL + Shift + Down* 

 CTRL + .* 

 CTRL + ,*  

 CTRL + Shift + N* 

 CTRL + G* 

Zoom to fit 
Zoom in 
Zoom out 
Object Properties 
Bring to Front 
Send to Back 
Forward one 
Backward one 
Lock selected objects (full stop) 
Unlock all (comma) 
Insert new object into frame 
Grid and Rulers set-up

 CTRL + H Toggle Hotspot on/off 



 Text Formatting Keys 

 Productivity 

Getting the most out of Multimedia Fusion should not end with Fusion itself. To 
conclude this article, here are some ways of getting more out of your working 
environment. 

 Wheel Mouse  

A wheel mouse can help you work faster in the Event and Frame editors, as 
they allow you to turn the wheel to scroll the workspace area without moving the 
mouse to the scroll bars This may sound like a gimmick, but it really does save 
you time. 

The most common wheel mouse is Microsoft's Intellimouse. This has one 
vertical wheel that also acts as a third button. There are other alternatives that 
offer two wheels, one for vertical and one for horizontal scroll bars. Having two 
wheels makes it even easier to navigate the MMF workspace, especially in the 
Frame editor. A two wheel mouse that I would recommend is the Ami Pro Wheel 
mouse. 

 Pen Tablets  

If you are serious about producing graphics for your MMF applications, you will 
benefit greatly from a graphics pen tablet. Using a pen shaped stylus does 
make a difference when drawing, but is not as easy to use for navigation in 
heavy applications. If possible, have a separate graphics workstation. If not, set 
up Windows profiles for a mouse and tablet. 

 Other Software  

Multimedia Fusion has a collection of advanced editors. For example, its picture 
editor is especially powerful. However, to seriously get the most out of your 

 CTRL + Q 

 CTRL + R 

Toggle Action point on/off 
Resize Canvas 
* In CnC, you could press D for Draw tool and F for Fill bucket tool 
amongst others to select drawing functions. This feature does not yet 
exist in MMF...

 CTRL + Shift +F* 

 CTRL + Shift + P* 

 CTRL + Shift + B* 

 CTRL + Shift + I* 

 CTRL + Shift + U* 

 CTRL + Shift + L*  

 CTRL + Shift + C* 

 CTRL + Shift + R* 

Choose Typeface 
Plain, no formatting 
Bold style 
Italic style 
Underline style 
Align Left 
Align Center 
Align Right



multimedia, you do need to use features available in specialised software. 

Some suggested software include (but not limited to): 

 2D Graphics - Photoshop, Paintshop Pro, Aura, Painter, ... 

 3D Graphics - 3D Studio / Max, Lightwave, Maya, ... 

 Digital Audio - Sound Forge, Goldwave, CuBase, ... 

 Music - MIDI Maker, MOD editors, Rebirth, ... 

 MMF Extensions - Visual C++ 4 and above. 
  

by Andy H 
Please do not copy or re-use without written permission.  


